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The Info Sheet
FLUSHING CAMERA CLUB
… in our 37th year
Member: Photographic Federation of Long Island (PFLI)
Member: Photographic Society of America (PSA)
“Together in friendship may we learn the art of photography”
It is Wednesday evening, December 16th and something is missing. Where is the Flushing Camera
Club meeting and the holiday party? I rushed home because tonight is the third Wednesday of the
month (and we all know what that means). When I got home, I remembered that because of a burst
water pipe, the December 16th meeting had to be cancelled and everything moved to December 30th,
the fifth Wednesday of the month. I guess, we were lucky that this year, there are five Wednesdays
in December, otherwise our plans and programs would really be messed up. So we won’t miss
anything, especially the food and camaraderie and good fellowship of the FCC holiday party.
According to weather.com, there is going to snow this month. That means a great opportunity to
make photos. Just remember that modern cameras, both digital and film, use batteries and
electronic shutters. And they don’t do well in very cold weather. So keep a spare battery warm and
swap it with the cold one when needed. Also, be careful of moisture freezing and lenses fogging. Oh
for the good old days of mechanical shutters and no batteries. But that would mean no through the
lens metering and manually setting shutter speed and aperture. I guess some would say that
photography was purer in those days, but today we get images that they would have to pass on. In
the old days, you thought Tri-X with an ISO of 400 was fast and you had to put up with a lot grain to
get the speed. Today, you can most newer cameras can produce low noise images with ISO
speeds of 800 and some cameras can get excellent result with ISO settings of 6400, that is 4 stops.
Add the 2 stops of image stabilization and you get 6 stops of better hand holding. And I haven’t
even gotten the whole subject of digital photo editing.
Also, today photography is blossoming with people always having cameras with them, either regular
point and shoots (so much better than the old “Brownie”) or in cell phones. There is even a cell
phone with a 12 megapixel sensor. Also, people share their images, not just with friends and family,
but with the whole world – Picasa, Flickr and moblogs (online blogs with uploaded pictures). And
isn’t sharing an important part of the Flushing Camera Club experience.
Let me wish you all a healthy and happy New Year. May all your images be 9’s. And may your
images portray what you see and feel and be as good as you want.

JANUARY
6: Competition #5, judge: Dave Gardner, Nikon employee, past FCC
President. Website: www.lensman.smugmug.com
20: Michelle Kawka, Commercial Photographer, RAW vs JPEG, e.g. the
potential advantage of shooting in RAW, and then conversion to JPEG. See
page 2 for additional information on Michelle Kawka.
FEBRUARY
3: Competition #6 Abstracts, judge: Yvonne Berger, Berger Brothers
17: Stan Strauss will demonstrate conversion of color images to black and
white. Bob Green will show 'how to tweak your images' or make something
from very little.
MARCH
3: Competition #7, judge: John Brokos, President, Freeport Camera Club

~ Stan Strauss
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Happy Birthday To You!

3: Victor Fichera

24: Shannon Cantu

9: Stan Goldstein

27: Grace Tucci

12: Joe Muratore

30: Susan Zigman

FCC NEWS
Michelle Kawka will present for FCC on Jan. 20.
Michelle is an award winning, internationally exhibited
New York based photographer specializing in portraiture, lifestyle,
corporate, fashion, travel, public relations and architectural work
for a wide variety of advertising and editorial clients. Her work has
been exhibited at Queens Museum of Art; the city Hall of the 9th
Arrondissenment, Paris, France; Queens Hospital Center; the
Gallery of Social and Political Art, Boston; New England School of
Photography. She completed a series of 200 portraits for the
website ThisIsOurQueens, a project depicting the lives of people
who live and work in her neighborhood, Queens which she
describes as “the most diverse place on Earth.”
ThisisOurQueens.com was named one o the best projects of
2009 by the American Society of Media photographers.

FCC Community Project
The FCC is moving ahead with plans for a contribution to our
community. A Committee is collecting digital images for a photo
show to present to a local nursing home. FCC members
are asked to contribute happy and positive images for this project.
The nursing home residents should respond to the visual
simulation and this will also be good for our members since we
have a lot of good talent.
Digital images should be sent to Joe Crupi: joecxlt@aol.com
If you have questions, contact any Committee member: Pat
Burns, Joe Crupi, Helen Repstad, Michael Sender.

- posterizations, solarizations
- texturized images
- deliberate camera movement blur
- extreme soft-focus
- zooming during exposure
This doesn't have to a Photoshop competition, instead
Try creating in camera. Of course, you can use photoediting to enhance or create abstracts. Just remember,
the image must start as a photograph that you have
taken

Create images for FCC Digital Competition (No
Border)
(Photoshop Elements Editor instructions)
1. Flatten the image
2. Make sure that the image mode is RGB and 8 bits / channel
(Image > Mode).
3. Open the Image Size dialog – (Image> Resize > Image
Size).
4. Make sure that Constrain Proportions is checked Resample
Image: is checked Bicubic Sharper is selected.
5. Change either the Width or Height (whichever is larger) to
750 pixels
6. Change the Resolution to 72 pixels/inch.
7. Click on OK.
8. From the File menu, select SAVE AS (File>Save As)
9. Type in File name as follows – c12-x1-yname-title where x is
a,b or s depending on your class yname is sstrauss for Stan
Strauss title is the title of your image.
10. Make sure that Format is JPEG.
11. Click on Save
12. Make sure that Quality is 12
13. Press OK and you are done.

Abstracts, by Stan Strauss
February 3 Competition will be a Restricted Competition. The
subject is ABSTRACTS. The judge for the competition is Yvonne
Berger. This is her definition of Abstract Photography Special attention to form, texture light, shadows and color.
may or may not represent the natural world.
If you don't have any ideas about what to present, here are some
that have been suggested. abstracts" - definition from Wade
Clutton of PSA
- reflections flipped upside down
- ultra-close ups showing an interesting piece of a larger
uninteresting object
- distortions
-

FCC MEMBERSHIP
50
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"A Little History of FCC Venues Through The Years"
by Marty Fleischer
Back in December, our meeting slated for December 16th was
cancelled due to a pipe leak in the auditorium. To the best of my
recollection, this was the 1st time since I joined the FCC in 1976
that a meeting was cancelled due to something like that. We
have had meetings cancelled before because of weather and
associated reasons (I think once the parking lot here was too
muddy). This led me to have a rather interesting conversation
with Dorothy online one evening as to where we've been over
the years. As this is my 34th year with our club, please allow me
to take you on a trip down memory lane (for those of us who are
here as long, or almost as long as me...for all of you others, it's
a good history lesson!):
As far as I know, we started at the Free Synagogue in Flushing
in 1972, and remained there until the 73-74 season. In 1974, we
moved to Booth Memorial Hospital, where we had meetings in
the C4 conference room, and a bigger room in the hospital. In
September 1979, we were told we would have to look again, and
starting in October, we moved the "Yellow Home" here @
Flushing Hospital.
This was on the site of where we are now, and apparently it
looked like the main hospital building back when they opened. A
picture of it is in the conference room. For the 1980-81 season
(after no summer sked for us, due to the closing of the "Home",
we moved to the main building next door (btw, like now, the
Home and the building we are in now were connected to the
main building). In May 1983, we moved to our present home,
where, except for a number of detours I will detail below, we've
been at ever since.
The exceptions to the above:
From time to time, we have had to use a room in the main
building when the aud is in use. From 1989-90 to May 1991, we
were in the trailer @ Alley Pond Environmental Center, and then
for Summer 91, we moved back to Flushing Hospital. In Sept
'97, we went back to APEC for one meeting, because we had a
parking problem in our lot. But, except for the time @ APEC, we
have been with Flushing Hospital for 3 decades now.
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Classes are free and open to the public
PFLI & Hillside Library, 155 Lakeview Road, New Hyde
Park. Photoshop Elements 7 classes at 6:45pm - 8:45pm:
January 19, 2010 - The Full Editor
March 23, 2010 - Sharing; Advanced Editing
38 persons registered for the November class; however,
approximately 50 were in attendance! If you plan to attend the
Elements 7 classes: You must register in advance:
516.355.7850
Classes are open to the public ...and are free.
Book: “The Keys To Great Photographs” with images and
text by Dick Hunt and is available for sale at $7.00. We’re
indebted to Dick Hunt for providing the tools for our book and to
the Education Committee for making the book a reality.

Book Review by Mike Kelly, President, Huntington
Camera Club “The Keys to Great Photographs”
At last, a well written easy to understand guide to taking great
pictures. 28 pages long and jam packed with the most useful
information you will find in any photography book.
Answering the question “How did they do that?” Richard’s book
leads you step by step thru the secrets to great photography.
Starting with chapter one “get it right in the camera.” all the way
thru to chapter 25 “Luck,” you will find page after page of useful
information to help get that “keeper” photo.
Contained in this book are all the tricks and tips that pro
shooters use to get the perfect shot. It explains about the rule of
thirds, leading lines and creating depth in your pictures. Every
page contains a new and easy to understand technique to
improve your photography.
Presented in a simple to understand format. Each technique is
presented with a pictorial example to make it so easy to
understand. The photography in this book alone is worth the
price I keep this book in my camera bag so I have an easy to
find reference any time I am out shooting.
f you have any budding photographers in your family, or would
like to make your photography more fun to practice, I highly
recommend this book .

I hope you have enjoyed our trip......

This link will lead you right to some examples in this book
http://www.pflionline.com/book.pdf
Website: www.pflionline.com; Delegate: Ron Caldwell

Marty: Thanks for sharing our rich history!

PFLI Camera Club Programs

PHOTOGRAPHIC FEDERATION OF LONG ISLAND
Competitions: Plainview Old-Bethpage Library, Plainview, NY,
competitions begins at 7:30pm: Friday January 8.
At our November competition we had 508 images...a new record
for us.

Photo Classes: PFLI & Plainview-Old Bethpage
Library, Plainview. At the November class, Dick Hunt
presented “the Keys to Great Photographs” and we had
approximately 150 attendees for the class. When we asked for
the number of attendees who were not members of a camera
club, almost half the attendees’ raised their hands. This presents
a great recruitment opportunity for the clubs.
Our next classes on Sundays at 2:00pm are:
Jan. 17: ”Understanding and Breaking the Rules of
Composition to Create Images beyond the Ordinary" by
Andreas Rentsch
Feb. 28: “Alternative Visions” by Gabriel Biderman

Lindenhurst Camera Club, January 21 2010, Bill Rudock of
First Light Photography will give a presentation on Portrait
Photography, showing how to set up lights, background, and
the model in order to get the right composition and light for the
best photo. For more information on Bill Rudock see the
following web site: www.firstlightphotography.com
Island Photo Group presents Steve Sint on Light Meters
and Lighting, sponsored by Sekonic Light meters.,
Monday, January 25, 2010, 7:30pm at TOB Bethpage Rink
Meeting Room, Stewart Ave. and Cheery Ave., Bethpage,
NY 11714.
Tickets are free: you must have a ticket for admittance: to
register; http://ipgsint.evenbrite.com
Learn Why Your In-Camera Meter is not enough. Program will
cover:
Difference between how the camera and the human eye sees
things.
How to use an incident light meter to get more consistent
exposure results.
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PHOTOGRAPHY HAPPENINGS
The following events are not a part of programs by the
Flushing Camera Club. They are shared for
information purposes only. FCC assumes no
responsibility for the events or information. For
additional information on these events, contact the
event.
Russ Burden Photography Tours Life’s too short to
miss out on a Russ Burden Nature Photography
Tour. www.russburdenphotography.com 303.791-9997
2010:
Feb. 17 - 24: Florida Birds: Everglades/Fort Myers / West
Palm - special low price.
Apr 17 - 23: Monument Valley / Slot Canyons
May 8 - 14: Arches + Canyonlands National Parks - includes
5 sessions of Photoshop instruction
May 22 - 31: Oregon Coast - 10 day trip
June 12 - 18: Tetons and Yellowstone Natl. Parks in Spring
Sept 23 - Oct 3: Tetons and Yellowstone Natl. Parks in Fall Oct. 19 - 24: Hunts Mesa - Aerial perspective of Monument
Valley includes TWO days in Capital Reef NP.
Nov. 2 - 8: Bryce Canyon and Zion National Parks
Dec. 4 -10: Bosque Del Apache / White Sands Natl. Mon.
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Island Operating Corporation.
According to Vlamis, "I found an eerie beauty there. I was
compelled to capture those places that were grotesquely beautiful:
the massive, bulky hulks of buildings, the elegant castles, the
stone and the light."
Suzanne Vlamis documented the architectural remains of the
abandoned sites over a period of three years, from 1969 to 1971,
often not knowing the names of the buildings, since there were
few identifying signs. Her companions were her cousin Theo, who
had worked at the island’s luncheonette, or a
boyfriend/bodyguard, whom she coaxed into accompanying her
over the Queensboro Bridge, through Queens and across the 36th
Avenue Bridge. As she wandered about the island, she might see
thieves stripping the copper from the buildings, or face a dog
eager to nip at her ankles as she rode by on her bicycle.
Welfare Island is where people were sent. Many lives were saved
and nurtured, and others expired," said Vlamis. The photographs
that she took forty years ago testify to this small island's
boundless capacity for healing and constitute a pause before the
start of a new, residential era.
Other anniversary events scheduled throughout 2010 will include
presentations about the history of the architecture and the parks
of Roosevelt Island, as well as the integration of hospital residents
into the community, plus a free summer outdoor movie series of
major motion pictures that were filmed on Roosevelt Island,
among other events and projects.

PHOTO EXHIBITION BEGINS 40TH ANNIVERSARY
CELEBRATION OF ROOSEVELT ISLAND

Nikon School: New Digital Seminars

Exhibit: Octagon Gallery, 888 Main St., Roosevelt
Island until Jan.31, 2010. Reception: Sat., Jan. 9, 2:006:00pm.

March 6, 2010; June 12, 2010

An exhibit of 32 photos is the first in a series of events that will
commemorate the 40th anniversary of the signing of the 1969
agreement between the City of New York and the State of New
York for the redevelopment of Welfare Island, as Roosevelt
Island was formerly called. The kick-off event, co-sponsored by
The Roosevelt Island Historical Society and The Roosevelt
Island Operating Corporation of the State of New York,
features photos taken before construction of a residential
community on the Island had begun.
Despite their forbidding air of abandonment, the massive castlelike buildings of Welfare Island fascinated Suzanne Vlamis,
compelling her to photograph these grotesquely beautiful
structures. The photos of the old hospitals, asylum, labs and
churches, taken by an adventurous young woman, were
exhibited in 1972. Welfare Island: A Spirit of Place Past, includes
these photos, as well as others never exhibited before. The show
is at the Octagon Gallery, 888 Main Street on Roosevelt Island,
from December 20 to January 31, 2010. An opening reception
will be held on Saturday, January 9, from 2:00 to 6:00 p.m.
"When I discovered a newspaper article that reviewed an
exhibition of photographs of Welfare Island, the former name of
Roosevelt Island, I knew I had to locate the photos and share
them with today's audience,” said Judith Berdy, President of The
Roosevelt Island Historical Society, which organized the
exhibition and is co-sponsor with The Roosevelt Island Operating
Corporation.
“Suzanne Vlamis managed to capture the life of the island at a
unique juncture; five of its seven active city institutions had
closed, and it had yet to be designated as the home of an
innovative experiment in housing and community-building,”
added Stephen Shane, Chief Executive Officer of the Roosevelt

Intro to Digital SLR Photography: all day; $119.00

Next Steps: Color, Light, Technology: all day; $159.00
March 7, June 13
Details & Registration: 631.547.8666; www.nikonschool.com

School of the International Center of Photography,
embraces all varieties of photography: from historical to
contemporary, from photojournalism to fine art making. ICP has
courses for 10 weeks, 5 weeks and weekend workshops, as well
as a list of special events. Classes include: Ditigal Photography,
Photoshop, Printing, Lighting, etc.1114 Avenue of Americans @
43 St., NYC 10036; 212.857.0001; www.icp.org

The Korean Connection Exhibit at Queens Museum of
Art highlights smorgasbord of digital works by Koreans living in
New York City. When: Wed.—Sunday: noon—6:00pm, until
February 21. The collection entitled Media, Media, is part of a
show of Korean art taking place in various venues across the city.
Scattered among other exhibitions at the Museum are a series of
photographs and videos by Korean artists. The exhibit is
organized by the Korean Cultural Service of NY to enhance
understanding of the country through cultural activities, including
art exhibits, music and dance events and film screenings. “A lot of
them found their original way to express their ideas about cultural
identify and the world. Sometimes they changed from pure realist
to abstraction here. They started to incorporate many objects from
daily life.”
Suggested donation: $5.00 for adults; $2.50 for seniors
Queens Museum of Art, Flushing Meadow Park, 718.592.9700;
queensmuseum.org
.
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Photography Classes by Neptune Photo: private tutoring
of General Photography, Using Your New Camera, Adobe
Photoshop, Lighting … and much more. Contact Neptune for
cost and other information: 130 Seventh Street, Garden City, NY
11530, 516.741.4484.
Photography Show, Assoc. of Intl. Photography Art
Dealers, the 30th edition of the show will open with a Gala
Preview on March 17, 2010. Show: March 18-21, 2010, Park
Avenue Armory, 643 Park Ave. (67 St.), NYC

”Portraits,” by David Paone, photojournalist. Adelphi Univ.,
Swirbul Library, 1 South Ave., Garden City, thru January 14.
516.877.4010; www.adelphi.edu

Metropolitan Museum of Art .. .1005 5th Ave., NYC,
212.535.7710, www.metmuseum.org
Surface Tension: Contemporary Photographs from the
Collection. “Photographs are often perceived as transparent
windows onto a three-dimensional world. Yet photographs have
their own material presence as physical objects. Surface Tension
highlights the ways in which artists use photographic and multimedia techniques to direct our attention to the physical surface of
the photograph.” Till May 16, 2010, Joyce and Robert Menschel
Hall for Modern Photography

Park West Camera Club’s extended field trip to Hawaii:
Big Island and Maui, April 17—May 1, 2010. Will include
Volcanoes National Park, Kilauea, Hilo, Tropical Forests,
Botanical and Sculptured Gardens, Zoos, Whale Watching,
Museums. www.parkwestcameraclub.org
Contact Chuck Pine for details: bohpine@aol.com

B&H Event Space, 420 9th Ave., NYC, 2nd floor, limited
space: eventspace@bhphoto.com
Free seminars and inspirational lectures by talented pros from
around the world. You can self-register on-line to guarantee a seat
OR they do accept walk-ins for events that haven’t reached
capacity.
Thurs., Jan. 7: 11am—1pm & 3:00-5:00pm: The New and
Improved Nikon Wireless Flash Hands-on Workshop with
Shooting Stations by Paul Van Allen
Tues., Jan. 12: 11am-1pm: Seizing the Moments of Time: The
Art of Long Exposures by Gabriel Biderman
3—5pm: Introduction to Digital Photography, Before & After the
Shoot—presented by International Center of Photography by
Lester lefkowitz
Wed., Jan 13: 3-5pm: Better Photographic Composition—Beyond
the Rules of Thirds by David Brommer
Thurs,, Jan. 14: 3-5pm: From Minor League to the Olympic
Games: Ron Wyatt’s Journey Through the World of Sports
photography by Ron Wyatt
Wed., Jan. 20: 11am-1pm: Unlocking the Hidden Power of Your
Digital Point and Shoot Camera by David Brommer
Sun., Jan. 24: 1-3pm: The Photo Essay; Learning to Tell A Story
Through imagery. Sponsored by Olympus, by David H. Wells
Wed., Jan. 27: 11am –1pm: a Year in the Life of an African
Wildlife Photographer by Andy Biggs.
Sun., Jan. 31: 1-3pm: Turning Long Term Projects into Books by
Harvey Stein
http://www.bhphotovideo.com/find/EventsPace.jsp
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Photo Workshops: New Mexico - Two award-winning
photographers have joined forces to create a new series of
photography field workshops in New Mexico. David Cramer
and Lynne Pomeranz will lead photographers of all levels on
exciting adventures to photograph and observe wild horses in
beautiful southwestern settings, seasonal outings to the world
famous Bosque del Apache, and other workshops that will
explore the culture and beauty of the Land of Enchantment.
These three to five day workshops will include educational
presentations and digital darkroom sessions. For more info
please refer to: www.wildhorseworkshops.com 505-897-4108
Lynne ; www.davidcramer.com 505-503-3929 David

Tuesday Evening Hour: Photography Lectures to
expose the works of artists to the public. On vacation till
January 5, 2010.
St. Margaret’s House, Dining Room, 49 Fulton St. (Block from
South Street Seaport), begins at 6:30pm, $2.00 donation. If
you want to present a show, contact: 212.964.3936,
www.tuesdayeveninghour

Outdoor News from Urban Park Ranger,
www.nycgovparks.org/rangers:
a.High Line, City’s Newest Public Park: 1st section of
High Line opened on June 8, ’09 as the highly-anticipated, new
public park built on top of a 1930’s-era elevated rail line. The
High Line is the first public park of its kind in the US, built 30
feet above Manhattan’s West Side. The opening of the first
half-mile section of the High Line is the culmination of more
than 3 years of construction and 10 years of planning. High
Line’s design is inspired by the wild, self-seeded landscape
that grew up naturally on High Line when trains stopped
running in 1980. It retains the original railroad tracks. An
integrated system of concrete pathways, seating areas and
special features blend with naturalistic planting areas to create
a singular landscape.
Access points from street level: at Gansevoort St., 14 St.
(elevator access) 16 St. (elevator), 18 St. & 20 Street will be
open during the Park’s operating hours: 7:00am – 10:00pm.
The opening of the first section of the High Line – Gansevoort
St. to 20 St. will be followed by completion and public opening
of the next segment from 20 Street to 30 Street.
.
PHOTOGRAPHY RESOURCES
Great Photos by Russ Burden: www.takegreatpictures.com
Hi-Tech Photo: 36 Middle Neck Rd., Great Neck, NY,
516.466.5885, or 1002 Old Country Rd., Plainview, NY 11803,
516.681.0262; www.Hi-TechPhoto.com; custom framing,
mounting, slide processing, b/w film processing, digital
printing.
Hunt’s Photo: Gary Farber, www.huntsphotoandvideo.com
Neptune Camera, 130 Seventh St., Garden City, NY;
516.741.4484
COSTCO—Photo Center– for prints

GUIDELINES for a GOOD IMAGE by the late
Felix Occhiuto
Impact

Composition

Technique

Originality

Print Quality

Complimentary
Mounting
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PHOTOGRAPHY LINKS
Flushing Camera Club: www.flushingcameraclub.org
PFLI: www.pflionline.com
PSA, Cosmo: www.cosmo-psa.org
Stan Strauss: http://www.stannich.com
Ron Caldwell: http://www.fotosbyron.com
www.photoplugins.com
Russ Burden: www.russburdenphotography.com
Online Display and Review: www.flickr.com
Digital Photography Review: www.dpreview.com
Canon Camera: www.usa.canon.com
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Subjects must be judiciously chosen. The more you
realize which ones work, the more you’ll add many
dramatic images to your files.
Backlit landscapes are mostly shot early and late in the
day when the sun is close to the horizon. Shape and
form of the subject become important as most texture
and detail is lost when shooting into the sun. But as with
all guidelines, there’s an exception. Autumn colored
leaves are great to shoot even in the middle of the day.
Backlit leaves take on a glow as if a switch was turned
on from within each creating a special translucence and
powerful image.

Nikon Camera: www.nikonusa.com
Adobe Photoshop: www..adobe.com

Photographing Mountains

Natl. Assoc. Photoshop Professionals: www.photoshopuser.com
B&H: www.bhphoto.com

There’s an old expression that’s a play on words: “Life’s
A Beach.” I have a T Shirt that says, “Life’s A Mountain,
Not A Beach.” From the very first time I drove across
country from New York to Denver and saw the mountains
loom in the distance as I neared the front range of the
Rockies, I was hooked.
Add Color For Impact: Autumn is my favorite time to
photograph mountains as the deciduous trees reach their
peak color. Whether you focus on the Rockies with
golden toned aspens or the rolling mountains of the east
with multi warm colored hardwood trees, the reds,
yellows, and oranges that paint the hillsides add
dimension, impact, and specific focal points to any
mountain image.

International Center for Photography: www.icp.org
For additional links, check the Flushing Camera Club’s Website

It’s About Russ Burden:
Russ is a long time FCC member who now lives in Colorado. He
leads exciting and challenging trips and each time I’ve joined him
on a trip, I’ve returned with great competition images.
See page 5 for a list of Russ’ tours. In addition to the tours, Russ
is an instructor at the Digital Photo Academy in Colorado.
I want to take this opportunity to thank all of you who supported
me by coming on one of my nature photo tours this year. For
those of you who weren't able to make it, I hope that 2010 is the
year for you. If you’ve never experienced the camaraderie,
excitement and enthusiasm of one of my outings, you need to sign
up with me in 2010. If you’ve never seen my unrelenting
dedication to find you the perfect image, then it’s essential you
sign up. I’ve been told that my motivation and enthusiasm are
contagious and I want you to catch it. But you need to be with me
in order for this to occur. Let’s make it happen.
There’s still some time left to sign up for the December tour to
White Sands and Bosque. I have 1 opening left.
As you know, I declared 2009 to be the Year of the Photo Tour
and it’s been a wonderful ride. My goal is to make 2010 even
more thrilling. Come join me so you can get the experience first
hand.
Visit my web site for more information or give me a call for the
details. Please share this with all your photographer friends.
Referrals are my best form of advertisement.
Regards and I look forward to having you join me on a tour in
2010. Russ Burden, 303.791-9997, rburden@ecentral.com
russburdenphotography.com

Create Depth: A key technique in creating successful
compositions of mountain scenics is to create depth. This
is accomplished by including fore, mid, and background
elements in the image. Wide angle lenses are employed
to accomplish this. By getting close to an important focal
point in the lower portion of the frame, the eye is drawn
to that area in the photograph. The midground layer
needs to support the chosen foreground element and
contain interest. The final piece of the puzzle is the
background element. When photographing mountains,
this is often the key peak of the range. In the end, all
elements should support one another.

Backlit Landscapes by Russ Burden

Timing: Dramatic mountain images are made in the
sweet light of the day. This occurs both at sunrise and
sunset. Capturing images at these times means getting
up when it’s dark and being on location just as the sun
crests the horizon. It also entails being out at sunset just
before the sun falls below the horizon. At these times of
the day, the light is warm and soft. It gives the scene
dimension and texture unobtainable in the middle of the
day when the sun is overhead.

Backlight can impart many looks to a landscape. It can emphasize
a strong silhouette, it can rim light a subject giving it a strong outer
glow, it can enhance the look of fog or mist, it can create shafts of
light highlighting specific portions, and it can provide you with a
sun star as the sun ever so slightly peeks from behind a portion of
the subject. It presents a unique quality of light that is often
overlooked by landscape photographers. It presents challenges,
but the rewards are worth the effort.

Quick Tips: I highly recommend you use a polarizer and
shoot at right angles to the sun to maximize its effect.
Use a long lens to compress scenes where layers of
mountains exist to add impact. Use a long lens to create
intimate portraits of just the peaks of your favorite range.
Incorporate people into some of your shots to show
scale. Shoot when there is an impending or clearing
storm to capture dramatic light.
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Today's Question: What are the pros and cons of
creating a copy of the Background layer in Photoshop
as one of the initial steps in my workflow? Should I
make a copy of the Background layer on every image I
edit, or are there situations that do not require a
background layer?

Today's Question: I received the photographer’s
files from my daughter’s wedding. They are all JPEG
in reasonably large files (5-7 Mb). Is there an
advantage to converting them to TIFF or PSD if I
need to do minor editing (enlarge/reduce, some
color correction) before making prints for the
family?

Tim's Answer: This is an issue I run into on a regular basis
when teaching workshops around the country and around
the world. It seems a relatively large number of
photographers have somehow gotten in the habit of
creating a copy of the Background image layer as the very
first step in their image-optimization workflow. In most
cases, doing so is completely unnecessary.
Let's start with the disadvantages, because this is the dealbreaker to me. After all, it seems to be a good idea to have
a backup copy of your "original" pixel values, so if you're
going to avoid doing so you really ought to have a strong
reason for doing so. In this case, the "strong reason" is that
the disadvantage of taking this approach is that when you
create a copy of your Background image layer you are
immediately doubling the base file size for your master
image file.
So, the question is, what are you getting for the doubling in
file size, and is it worth it? In short, in most cases it isn't
worth it.
I almost never create a copy of the Background image layer, and
when I do, it is only because there is no other alternative available
while maintaining a non-destructive workflow. For example, if all
I'm doing is applying adjustments via adjustment layers (which are
entirely non-destructive), why would I bother creating a copy of
the Background image layer? Why double the file size when, by
virtue of the fact that I'm using adjustment layers, I'm not putting
my Background image layer at risk anyway?
My philosophy for image-optimization in Photoshop calls for
always using an adjustment layer or separate image layer when
applying adjustments. Of course, there are situations where it is
necessary to use a copy of the Background image layer to
accomplish a given task. For example, the "Average Blur"
technique for dealing with particularly strong color casts I present
on my "Photoshop Hands-On: Image Cleanup" DVD
(www.timgrey.com/videos.htm) requires that you create a copy of
the Background image layer in order to apply the technique.
The bottom line is that I only create a copy of the Background
image layer when it is the only way I can accomplish a particular
adjustment in a non-destructive way. But if I don't need to create a
copy of the Background image layer, I don't bother, because it
won't provide any real benefit and it will cause a doubling of the
base file size.
Contents of this e-mail are copyright by Tim Grey. All Rights
Reserved.

Tim's Answer: There is some advantage, but it is
largely theoretical and it assumes what I think of as a
"typical" approach to touching up the image. Specifically,
if you actually apply changes and then re-save the files
as JPEG images, then JPEG compression will be
applied to the image. That means compression was
applied once when the image was originally saved as a
JPEG (either during capture if the photographer
captured in JPEG mode or after converting if the images
had been captured in RAW), and then again when you
re-save the image after applying your adjustments.
However, assuming your adjustments are indeed
relatively minor and that you only save them again once,
the difference will be truly minor, to the extent that
nobody would be able to see any difference in the final
print. Even with a magnifying glass. So as long as you
keep your adjustments minor you can feel comfortable
keeping the images in JPEG mode, using the maximum
Quality setting of 12 when you do re-save he final result
for each image as a JPEG.
If you're going to do any extensive work on the images, I
would naturally recommend working with adjustment
layers or other layers as needed in order to apply the
changes, and then save the resulting file with all layers
intact as either a TIFF or PSD file. You can always use
that file as the basis for other output, such as printing
directly, or saving that master image as a JPEG as
needed for specific purposes (for example, sharing via
email).
There's no question the absolute best approach to optimizing
any image (from the perspective of flexibility and ultimate
image quality) is to utilize a layer-based non-destructive
workflow (such as through the use of adjustment layers, as
covered on my DVD, "Photoshop Hands-On: Adjustments",
available through my online store at www.timgrey.com/store/).
However, when appropriate caution is taken you can still
produce excellent images while keeping those images in the
JPEG file format. It is similar to the fact that you'll improve
flexibility and image quality by capturing in RAW, but can still
produce excellent images capturing in JPEG mode.
I might add that even though the photographer presumably
has a copy of the original captures, you should also be sure to
make a backup copy (ideally more than one) of these
important images.

